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Note

This document and other information from Parker-Hannifin Corporation, 

its subsidiaries and authorized distributors provide product or system 

options for further investigation by users having technical expertise. 

The user, through its own analysis and testing, is solely responsible for 

making the final selection of the system and components and assuring 

that all performance, endurance, maintenance, safety and warning re-

quirements of the application are met. The user must analyze all aspects 

of the application, follow applicable industry standards, and follow the 

information concerning the product in the current product catalog and in 

any other materials provided from Parker or its subsidiaries or authorized 

distributors. 

To the extent that Parker or its subsidiaries or authorized distributors 

provide component or system options based upon data or specifications 

provided by the user, the user is responsible for determining that such 

data and specifications are suitable and sufficient for all applications and 

reasonably foreseeable uses of the components or systems.
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1. Introduction

Ordering Code D*FB

Nominal

size

Direct. 

control 

valve

Spool-

type
(see 

catalogue)

Command-

signal

Seal

NBR
(different seal 

compound by 

request)

Design 

series

Option

D NF B 0

Code Nominal size

1 NG06 / CETOP 3

3 NG10 / CETOP 5

Code Spool position

C

E

K

Code
Command 

signal
Function Connection Option

F0 0...+/-10V 0...+10V > P-A 6 + PE Pot.-supply

S0 4...20mA 12...20mA > P-A 6 + PE –

W5 1) 0...+/-10V

4...20mA

0...+10V > P-A

12...20mA > P-A
11 + PE

Pot.-supply & 

command preset 

channel

D*FB

Spool 

position

Code Design

0
Spool/sleeve 

design

3
Spool/body 

design

Design

1) Factory set +/-10V
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Ordering Code D*1FB

D

Direct. 

control 

valve
Spool 

type
(see 

catalogue)

Spool 

position

Proportional 

control

NG06

pilot *

Command 

signal

N1 B

Seal

NBR
(other seal 

compound 

on request)

Design 

series

Flow
(see 

catalogue)

Pilot 

connection

F C

Nominal

size

Valve 

accessories

Option

Code
Valve 

accessories

0 Standard

8 Monitor switch

Code
Command 

signal
Function

Connec-

tion
Option

F0 0...±10V 0...+10V > P-B 6 + PE Pot.-supply

M0 0...±10V 0...+10V > P-A 6 + PE Pot.-supply

S0 4...20mA 12...20mA > P-A 6 + PE —

G0 0...±20mA 0...+20mA > P-B 6 + PE —

W5
0...±10V

4...20mA

0...+10V > P-A

12...20mA > P-A
11 + PE

Pot.-supply 

& command 

preset 

channels

1)  with enlarged connections 

 Ø 32 mm

Code Nominal size

3 NG10 / CETOP05

4 NG16 / CETOP07

9 1) NG25 / CETOP08

11 NG32 / CETOP10

Code Inlet Drain

1 internal external

2 external external

4 internal internal

5 external internal

* as D1FV* separately available
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Parker D*FB/D*1FB proportional directional control 

valves have an integral electronic and requires only 

one sole electrical common for the control system. 

Different flow sizes, as well as command signal op-

tions are available to achieve an optimal adaption 

for different applications.

Characteristics of Valve Driver 

The described integral electronic driver combines 

all necessary functions for the optimal operation of 

the valve. The most important features are: 

•฀ digital circuit design

•฀ high dynamic constant current solenoid control 

•฀ differential input stage with various command 

signal options

•฀ four quadrant ramp function

•฀ MIN adjustment for deadband compensation

•฀ MAX adjustment to match the command signal 

span to the valve operating range

•฀ optional reference outputs +/- 10 V for potentio-

meter supply

•฀ optional four parametrizable preset recall chan-

nels

•฀ standard central connection

•฀ compatible to the relevant European EMC-

standards

•฀ comfortable interface program

Name Plate Example Block Diagram of Integral Electronics

Code F0/M0 (6+PE)

Code S0/G0 (6+PE)

Code W5 (11+PE)

18

18

S0: 4...12...20mA
G0: 0...±20mA

18
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Technical Data

General

Model Proportional directional control valve, direct operated (D*FB), pi-

lot operated (D*1FB)

Drive Proportional solenoid

Mounting Pattern NG6 (CETOP 3) / NG10 (CETOP 5) 

NG16 (CETOP 7) / NG25 (CETOP 8) / NG32 (CETOP 11)

Installation Position Any

Hysteresis D1FB*0/D3FB*0 [%] < 4

  D3FB*3/D*1FB [%] < 5

Ambient Temperature Range [°C] -20...+60

Protection Class NEMA 4 (IP 65) acc. EN 60529

Vibration Strength [G] 10 Sinus 5...2000 Hz acc. IEC 68-2-6

30 Random noise 20...2000 Hz acc. IEC 68-2-36

15 Shock acc. IEC 68-2-27

Weight [kg] NG6: 3 / NG10: 7 / NG16: 11 / NG25: 19.5 / NG32: 61

Hydraulic

Fluid Hydraulic oil according to DIN 51524...535, other on request

Viscosity permitted [cSt]/[mm2/s] 20...400

Fluid Temperature [°C] -20...+60 (NBR: -25...+60)

Filtration ISO 4406 (1999); 18/16/13

Operating Pressure max. (D*FB)

 Pilot oil intern (D*1FB):

 Pilot oil extern (D*1FB):

[bar]

[bar]

[bar]

350 for ports P, A, B  /  210 for port T

350 for ports P, A, B, X / 185 for T, Y

350 for ports P, A, B, T, X / 185 for Y

Electrical

Duty Ratio [%] 100

Supply Voltage Us [VDC] 18...30, ripple < 5% eff., surge free

Current Consumption max. [A] D1FB: 1.5 / D3FB: 2.0 / D*1FB: 1.5

Pre-Fusing [A] D1FB: 2.0 / D3FB: 2.5 / D*1FB: 2.0

Potentiometer supply Up [V] ± 10 / ± 5 % max. 10 mA

Command Signal Options Uc

  

 Ic

[V] 

[mA]

[mA]

Codes F0, M0, W5: +10...0...-10, ripple < 0.01 % eff., surge free,  

Ri = 100 kOhm

Codes S0 & W5: 4...12...20, ripple < 0.01 % eff., surge free,  

Ri = 200 Ohm

< 3.6 mA = enable off, > 3.8 mA = enable on (acc. NAMUR NE43)

Code G0: +20...0...-20, ripple < 0.01 % eff., surge free,  

Ri = 200 Ohm

Differential Input Voltage max. [V] Codes F0, M0, S0, G0: 30 for terminal D and E against PE (terminal G)

[V] 11 for terminal D and E against 0V (terminal B)

[V] Code W5: 30 for terminal 4 and 5 against PE (terminal PE)

[V] 11 for terminal 4 and 5 against 0V (terminal 2)

Channel Recall Signal Uch [V] 0...2.5: Off / 5...30: On / Ri = 100 kOhm

Adjustment Ranges Min [%] 0...50

 Max [%] 50...100

 Ramp [s] 0...32.5

Interface RS 232C, parametrizing connection 5pole

EMC EN 61000-6-2, EN 61000-6-4

Central Connection Codes F0, M0, S0, G0:  6 + PE acc. EN 175201-804

Code W5: 11 + PE acc. EN 175201-804

Cable Specification [mm²] Codes F0, M0, S0, G0: 7 x 1.0 (AWG16) overall braid shield

[mm²] Code W5: 11 x 1.0 (AWG16) overall braid shield

Cable Length max. [m] 50
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Signal flow diagram
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2. Safety Instructions     

Please read the operation manual before installa-

tion, startup, service, repair or stocking! Paying no 

attention may result in damaging the valve or in-

corporated system parts.

    

Symbols

This manual uses symbols which have to be fol-

lowed accordingly:

      

 Instructions with regard to the warranty

     

 Instructions with regard to possible dama-

ging of the valve or linked system compo-

nents

  

 Helpful additional instructions

     

Marking, Name Plates

Instructions applied on the valve, i.e. wiring dia-

grams and name plates, must be observed and 

maintained legibly.

      

Work at the Valve

Workings in the area of installation, commission-

ing, maintenance and repair of the valve may only 

be allowed by qualified personnel. This means per-

sons which have, because of education, experience 

and instruction, sufficient knowledge on relevant di-

rectives and approved technical rules.

     

3. Important Details

Intended Usage

This operation manual is valid for proportional di-

rectional control valves D*FB/D*1FB series. Any dif-

ferent or beyond it usage is deemed to be as not 

intended. The manufacturer is not liable for warran-

ty claims resulting from this.

Common Instructions

We reserve the right for technical modifications of 

the described product. Illustrations and drawings 

within this manual are simplified representations. 

Due to further development, improvement and 

modification of the product the illustrations might 

not match precisely with the described valve. The 

technical specifications and dimensions are not 

binding. No claim may resulting out of it. Copy-

rights are reserved.

Liability   

The manufacturer does not assume liability for dam-

age due to the following failures:

•฀ incorrect mounting / installation 

•฀ improper handling   

•฀ lack of maintenance   

•฀ operation outside the specifications

  

 Do not disassemble the valve! In case of sus-

picion for a defect please return the valve to 

the factory.

Storage   

In case of temporary storage the valve must be 

protected against contamination, atmospheric ex-

posure and mechanical damages. Each valve has 

been factory tested with hydraulic oil, resulting in 

protection of the core parts against corrosion. Yet 

this protection is only ensured under the following 

conditions:    

 Outdoor storage or within sea and tropical cli-

mate will lead to corrosion and might disable 

the valve!    

Storage 

period
Storage requirements

12 months
constant humidity < 60% as well 

as constant temperature < 25°C 

6 months
varying humidity as well as   

varying temperature < 35°C
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4. Mounting / Installation

Scope of Supply

Please check immediately after receiving the valve, 

if the content is matching with the specified scope 

of supply. The delivery includes:

•฀ valve

•฀ operation manual

The central connector assembly as well as the pa-

rametrizing cable has to be ordered separately and 

are not included in the delivery.

 Please check the delivery immediately after 

receiving the shipment for apparent damages 

due to shipping. Report shipment losses at 

once to the carrier, the insurance company 

and the supplier!

Mounting     

•฀ Compare valve type (located on the name plate) 

with part list resp. circuit diagram.

•฀ The valve may be mounted fix or movable in 

any direction.

•฀ Verify the mounting surface for the valve. Un-

eveness of 0.01 mm/100 mm, surface finish of 

6.3 µm are tolerable values.

 Keep clean valve mounting surface and work 

environment!   

•฀ Remove protection plate from the valve mount-

ing surface 

•฀ Check the proper position of the valve ports 

and the O-rings.

•฀ Mounting bolts:  

D1FB: 4 pcs. M5x30  

D3FB: 4 pcs. M6x40 

D31FB: 4 pcs. M6x40 

D41FB: 2 pcs. M6x55 / 4 pcs. M10x60  

D91FB: 6 pcs. M12x75 

D111FB: 6 pcs. M20x90  

use property class 12.9, DIN 912

 Parker offers bolt kits:

 D1FB: BK375, D3FB: BK385, D31FB: BK385, 

D41FB: BK320, D91FB: BK360, D111FB: 

BK386

•฀ Tighten the bolts crisscross with the following 

torque values:  

D1FB: 7.6 Nm / D3FB: 13.2 Nm 

D31FB: 13.2 Nm, D41FB: 13 (63) Nm, D91FB: 

108 Nm, D111FB: 517 Nm

 Insufficient condition of the valve mounting 

surface migth create malfunction! 

 Incorrect mounting resp. bolt torque may re-

sult in abrupt leakage of hydraulic fluid on the 

valve ports.

Operation Limits    

The valve may be operated within the determined 

limits only. Please refer to the “technical data“ sec-

tion as well as to the “characteristic curves“ in the 

catalog. 

   

 Follow the environmental conditions! Unallo-

wable temperatures, shock load, aggresive 

chemicals exposure, radiation exposure, il-

legal electromagnetic emissions may result 

in operating trouble and may lead to failure! 

Follow the operating limits listed in the “spe-

cifications“ table!

   

Pressure Fluids

The following rules applies for the operation with 

various pressure fluids:

 

 The above information serves for orientation 

and does not substitute user tests among the 

particular operating conditions. Particularly no 

liabiliy for media compatibility may be derived 

out of it.

mineral oil usable without restriction

HFA oil-in-water emulsion consultation required

HFB water-in-oil emulsion consultation required

HFC aqueous solution (glycols) consultation required

HFD unhydrous fluids (Phosphor-Ester) consultation required

 For detailed information concerning pres-

sure fluids note VDMA-document 24317 as 

well as DIN 51524 & 51502.   

Special gaskets may be available depending 

on the utilized fluid.

 In case of insecurity please consult the fac-

tory.
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Electrical Connection

The electrical connection of the valve takes place 

by one common cable, which is coupled to the in-

tegrated electronic driver by a central connector 

assembly.

     

The connection Codes F0/S0 requires a 6 + PE fe-

male connector EN 175201-804.

 The female connector has to be ordered se-

parately under article nr. 5004072.   

 

 A female connector with metal housing is re-

quired! Plastic made models may create func-

tion problems due to insufficient EMC-cha-

racteristics.    

     

The connecting cable has to comply to the follow-

ing specification:

Cable type control cable, flexible, 

  7 conductors, overall braid   

  shield   

Cross section min. AWG16/1.0 mm2

Outer dimension 8...12 mm

Cable length max. 50 m

 For cable lengths > 50 m consult factory.  

 

The connection cable is coupled to the female con-

nector by solder joints.

Skinning lengths for the connecting cable:

The connection Code W5 requires a 11 + PE fe-

male connector EN 175201-804.

 The female connector has to be ordered se-

parately under article nr. 5004711.   

 

 A female connector with metal housing is re-

quired! Plastic made models may create func-

tion problems due to insufficient EMC-cha-

racteristics.    

     

The connecting cable has to comply to the follow-

ing specification:

Cable type control cable, flexible, 

  11 conductors, overall braid  

  shield   

Cross section min. AWG16/1.0 mm2

Outer dimension 12...15 mm

Cable length max. 50 m

 For cable lengths > 50 m consult factory.

    

The connection cable is coupled to the female con-

nector by crimp contacts.

Skinning lengths for the connecting cable:

 For the workmanlike termination of the crimp 

contacts the tool # 932 507-001 – supplier: 

Hirschmann – is required. 

 Do not disconnect cable socket under tensi-

on!
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Electrical Interfacing

  

Supply Voltage:  

The supply voltage for the valve has to cover the 

range of 18...30 V. The residual ripple may not ex-

ceed 5% eff.

  

 The applied power supply must comply to 

the relevant regulations (DIN EN 61558) and 

must carry a CE-mark. The operating voltage 

for the valve must be free of inductive surges. 

Do not exceed the max. value of 30V! Non-

observance of this rule may result in perma-

nent damaging of the valve.

  The increased inrush current of the valve 

should be considered when selecting the 

power supply. A stabilized power supply with 

overcurrent limiting feature should not be 

used. Due to the inrush current of the valve 

the current limit circuit may respond prema-

turely and create problems during energizing 

of the supply voltage.

 The operation of the valve is blocked if the 

supply voltage polarity is interchanged.

 Each valve requires a separate pre-fuse (ra-

ting: s. techn. data). Non-observance of this 

instruction may create irreparable damage of 

valve resp. incorporated system parts.

The shielding has to be assembled according the 

outline below:

The backshell nut of the cable gland has to be tight-

en with a suitable tool. The target value for the tight-

ening torque is 4 Nm. Tighten the cap nut with a 

torque of approx. 5 Nm after attaching the female 

connector on the socket outlet.  

 Incomplete tightening of backshell nut resp. 

cap nut may result in automatic release of the 

connection as well as degradation of the wa-

ter tightness.

 Follow the “instructions for use“ for installati-

on of female connectors made by other kind 

of brands!    

 The cable connection to the female connec-

tor has to take place by qualified personnel! 

A short between individual conductors resp. 

to the connector housing, bad soldering as 

well as improper shield connection may result 

in malfunction and breakdown of the valve. 

   

     

 The mounting surface of the valve has to be 

carefully tied to the earth grounded machine 

frame. The earth ground wire from the valve 

connecting cable as well as the cable shield 

have to be tied to the protective earth termi-

nal within the control unit. It is necessary to 

use a low ohmic potential connection bet-

ween control unit and machine frame to pre-

vent earth loops (cross section AWG 6).
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Wiring diagram of supply voltage

Code F0/M0/S0/G0 (6 + PE)

Code W5 (11 + PE)

 Incorrect signal amplitude levels may disturb 

the functionality and can damage the valve.

 The option 4...20 mA uses the “0 mA“ condi-

tion as breakdown-information. This means 

the presence of an evaluable failure informa-

tion if the input signal line is interrupted. In 

this case the actuator drive will be switched 

off. The drive will switch on when the input si-

gnal reaches a value of 3.8 mA, it switches 

off when the command falls below 3.6 mA. 

This determination follows the NAMUR-spe-

cification NE43.

 NAMUR is an association of users of process 

control technology.

Command signal input:

The command signal for the valve will be connect-

ed to the difference signal input of the electronic 

driver. The solenoid current behaves proportional to 

the command signal amplitude. Different versions of 

command signal processing are available, depend-

ing on the valve type. These are described below:

For the function description is assumed as signal 

reference (0V):

Code F0/M0/S0/G0: pin E, Code W5: pin 5

 Details are shown from the technical specifi-

cations.

 

 The command input signal needs to be filte-

red as well as free of inductive surges and 

modulations. Due to the sensitivity of the val-

ve a high signal quality is recommended, this 

will prevent malfunction.
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B

C
D

E

F B

C

A

valve

potentiometer
command signal

control system

Uc

-Up

+Up

-10 V+10 V

5...10 k

Wiring diagram of voltage command input +10...0...-10 V Code F0/M0 (6 + PE)

Wiring diagram of voltage command input +10...0...-10 V via potentiometer Code F0/M0 (6 + PE)

 The external potentiometer is fed 

via the output “potentiometer sup-

ply”. To prevent this output from 

overload, the resistance value of 

the potentiometer should be within 

a range of  5...10 kOhm. A nomi-

nal power rating of 0.1 W is suffi-

cient.

B

C
D

E

F

A

Uc

0V
command
signal

control system

valve
command signal

0...+10 V

U D-E

0 V

U D-E

0...-10 V

U D-E

function

function

function

D*1FB*K0

D*1FB*F0

D*FB*F0
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Wiring diagram of voltage command input +10...0...-10 V

Code W5 (11 + PE)

Wiring diagram of voltage command input +10...0...-10 V via potentiometer

Code W5 (11 + PE)

Uc

0V
command
signal

control system valve

command signal

0...+10 V

I 4-5

0 V

I 4-5

0...-10 V

I 4-5

4 5

function

D*FB

D*1FB

function

valve

command signal

0...+10 V

U 4-5

0 V

U 4-5

0...-10 V

U 4-5

potentiometer
command signal

control system

Uc

-Up

+Up

-10 V+10 V

5...10 k

4 5

2
10

9

function

D*FB

D*1FB

function

Wiring diagram of current command input +20...0...-20 mA Code G0 (6+PE)

D*1FB*G0

I D-E
0...+20mA

I D-E
0mA

I D-E
0...-20mA

command
signal

control system

valve
command signal function

le

le
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Wiring diagram of current command input 4...12...20 mA

Code S0 (6 + PE)

Wiring diagram of current command input 4...12...20 mA

Code W5 (11 + PE)

B

C
D

E

F

A

Ic

Ic

12...20 mA

I D-E

12 mA

I D-E

4...12 mA

I D-E

< 3.6 mA

I D-E

> 3.8 mA

I D-E

command
signal

valve

command signal

control system

actuator
drive off

actuator
drive on

function

Ic

Ic
command
signal

control system valve
command signal

12...20 mA

I 4-5

12 mA

I 4-5

4...12 mA

< 3.6 mA

> 3.8 mA

I

I

I

4-5

4-5

4-5

4 5

actuator
drive off

actuator
drive on

function
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Recall channels for internal command preset

Up to six corresponding inputs are provided for 

channel recall of internal command presets. The 

conjunction     

options of the internal command channels may be 

selectable via the parameter E21. The following op-

tions are      

provided:     

•฀ priority dependent  

•฀ additive    

 

At priority dependent channel recall the channel 

with the lowest numerical designation has priority 

against other      

simultaneously adressed preset channels.  

   

Example: Channels S1, S2, S3 are adressed.

Channel S1 has priority, the corre-

sponding internal command will be 

assessed as input signal. 

 

The preset channels have priority against the an-

alog signal input for the external command.   

  

At additive channel recall the internal signal presets 

of the recall channels as well as a possible signal 

at the external signal input will be added. The sum 

of the signal values is limited at 100%.

Example 1: Channel S1 = +50%, channel S2 = +20%, 

external input signal = +5V (= +50%). The 

sum is +120%, in this case +100% input 

signal will be assessed.

    

Example 2: Channel S1 = +50%, channel S2 = +20%, 

external input signal = -5V (= -50%). The 

sum is +20%, in this case +20% input 

signal will be assessed.   

 

The preset channels are switched through during 

the signal trigger at the dedicated inputs.

    

 More details are shown from the technical 

data.    

     

 The channel recall signals needs to be filte-

red as well as free of inductive surges and 

modulations. To prevent malfunctions a high 

signal quality is recommended.

Wiring diagram of recall channels

Code W5 (11 + PE)
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Cable Specification

The connection of the valve electronic to a PC re-

quires a special cable. It may be ordered under code 

40982923. The cable has to be inserted between 

an unused serial port COM1 or COM2 of the PC 

and the 5pole socket connector of the valve elec-

tronic (parametrizing connector).   

     

 Before connecting of the parametrizing ca-

ble a cover plug has to be removed from the 

electronic housing.

 Attention! The valve electronic provides no 

USB interface, but can only be parametrized 

via an RS232 - connection. Therefore the usa-

ge of USB standard cables is permitted and 

may result in damaging of valve resp. PC.

Hardware requirements 

•฀ PC with operating system from Windows® 95 

upwards 

•฀ Interface RS232  

•฀ display resolution min. 800 x 600 

•฀ connection cable between PC and electronic 

module 

•฀ storage requirement approx. 4 MB 

 It is recommended to select “small fonts” at 

the display setting, otherwise distortion of the 

display may occur.

ProPxD parameterizing software:

The ProPxD software permits comfortable parame-

ter setting for the module electronic. Via the clearly 

arranged entry mask the parameters can be noticed 

and modified. Storage of complete parameter sets 

to floppy or hard disk is possible as well as printout 

or record as a text file for further documentation. 

Stored parameter sets may be loaded anytime and 

transmitted to other valves. Inside the electronic a 

nonvolatile memory stores the data with the option 

for recalling or modification.

Features

•฀ comfortable editing of all parameters

•฀ depiction and documentation of parameter sets

•฀ storage and loading of optimized parameter 

adjustments

•฀ executable with all actual Windows® operating 

systems from Windows® 95 upwards

•฀ plain communication between PC and electron-

ic via serial interface RS232.

Comfortable interface, see Parker freeware avail-

able from infohcd@parker.com.

5. Operating Instructions

Basically the valve performs the task of converting 

a command signal into a proportional spool stroke 

with the highest possible dynamic. For these pur-

poses the input value will be electronically pro-

cessed and provides via a power amplifier stage 

the required current for the valve solenoid.

ProPXD screenshot
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Parametrizing connection Parametrizing cable 40982923

 The cover plug has to be re-installed after 

completion of the parametrizing work.

Program installation

Please check before installation if the above hard-

ware requirements are met. If your PC has already 

stored an older version of the “ProPxD” program, it 

has to be deinstalled by using the Windows® - sys-

tem control feature.

Program installation sequence:

•฀ terminate the execution of other programs

•฀ insert ProPxD-software CD

•฀ execute the file “setup.exe”

•฀ follow the instructions on the screen 

Answer the question, if an older version should be 

overwritten, with “ok”. During the installation you 

may change destination drive resp. installation 

path, if needed (i.e. if the storage space on drive 

“c” is not sufficient).

Please answer also “ok” if at the end of the instal-

lation the program reports any system information. 

After successful installation the desktop display 

shows the ProPxD icon for starting the program.

Software Operating

Brief instruction for first startup:

•฀ Connect the valve electronic to the supply voltage.

•฀ Connect the valve electronic to a PC via the pa-

rametrizing cable.

•฀ Click on the ProPxD icon to start the operat-

ing program.

•฀ After displaying the program resp. data base ver-

sion a program window opens and the connect-

ed valve will be automatically identified (possibly 

a manual identification via the button “Receive 

all” is necessary).

•฀ Select the desired version via the menu “Op-

tions/Optionen” with the menu item “Language/

Sprache”.

•฀ The valve specific default parameters are already 

available within the parameter table.

•฀ Individual parameters may be selected via 

mouse or the arrow buttons at the center of the 

program screen.
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•฀ Parameter changes are possible via mouse or 

the arrow buttons on the bottom left within the 

program screen, also the parameter values may 

be edited via the keyboard.

•฀ Modified parameters will be stored via the “En-

ter” key or via the button “Update list”.

•฀ After completing of all modifications, the entire 

parameter set may be transmitted to the valve 

via the button “send all”, also the parameters 

will be nonvolatile stored.

•฀ The chosen parameters may be optionally stored 

on the PC via the “File”-menu with the menu item 

“Save as”, data retrieving is always possible via 

the function “Load out of database”

Extended functions:

The user software is shared into 2 parameter 

ranges: 

•฀ basic mode 

•฀ expert mode 

 

For normal startup the basic mode is absolutely suf-

ficient. It permits the setting of all application spe-

cific parameters to match the valve function with 

the task setting. 

In case of special applications the valve parame-

ters may be adapted via the expert mode. 

The operating mode may be selected from the “Op-

tions”- menu and remains after terminating and re-

start of the program. 

 Changing of expert parameters is only permit-

ted for qualified personnel. Incorrect settings 

may lead to malfunction! In case of parameter 

changes shut the drive down!

To prevent an unauthorized access for the ex-

pert mode, a pass word is requested. The name is 

“parker” and cannot be changed. Thus additional-

ly to the button “Default” for loading of the default 

parameters, the button “Send parameter” appears 

in the “Expert”-operating mode. This button trans-

mits only the setting of one single parameter to the 

connected valve. Thus a quick tuning of single pa-

rameters is permitted during the setup.  

 A horizontal bar graph readout between 

the communication buttons shows the data 

transfer state.

 

 Because the ProPxD program has also offline 

(i.e. without connection to the valve) function-

ality, a manual pre-selection of the parameters 

is possible. After selection of the valve type 

via the menu “Options” the parameters may 

be set and stored for later transmission.

 Note the design series while selection of the 

valve!

 

The “File” menu provides the functions “Printer 

setup”, “Print preview” and “Print”. The print pre-

view includes the option for parameter set storage 

as text file (format  .txt) prior to further processing. 

The “Options” menu provides also the selection of 

the RS232 interface port via the menu item “Port”. 

Via the menu item “Load out of database” previ-

ously stored parameter sets may be loaded. 

 

Adjustment parameters 

The available parameters may be divided into 

multiple groups and are characterized by different 

letters: 

S-parameters

P-parameters

E-parameters
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Parameter overview for basic mode

Parameter Description Unit
Parameter Range Default 

Setting
Comment

from up to

S1 internal Sollwert S1 % -100 100 0.0

code W5 only
S2 internal Sollwert S2 % -100 100 0.0

S3 internal Sollwert S3 % -100 100 0.0

S4 internal Sollwert S4 % -100 100 0.0

S5 ramp accel. channel A ms 0 32500 0

S6 ramp decel. channel A ms 0 32500 0

S7 ramp accel. channel B ms 0 32500 0

S8 ramp decel. channel B ms 0 32500 0

P3 MAX channel A % 50.0 100.0 100.0

P4 MAX channel B % 50.0 100.0 100.0

P7 MIN channel A % 0.0 50.0 0.0

P8 MIN channel B % 0.0 50.0 0.0

P11 polarity command – 0 1 0

E17 option command –
1 = ±10V 

1 =  ±10V code W5 only
3 = 4-20mA

E19
cable break detection 

command
– 0

0 = ±10V
0 = +/-10V

codes S0 & W5 

only1 = 4-20mA

E25 MIN operating threshold –
0 = 1%

0 = 1%
1 = 0.01%
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Individual Description of Basic Parameters

S1

command signal S1

Adjustment of the internal command signal channel S1.

To attenuate of an external accessible command signal.

S2

command signal S2

Adjustment of the internal command signal channel S2.

To attenuate of an external accessible command signal.

S3

command signal S3

Adjustment of the internal command signal channel S3.

To attenuate of an external accessible command signal.

S4

command signal S4

Adjustment of the internal command signal channel S4.

To attenuate of an external accessible command signal.

S5

ramp accel. channel A

Adjustment of ramp rate for increasing of the positive signal polarity.

To avoid switching noise.

S6

ramp decel. channel A

Adjustment of ramp rate for decreasing of the positive signal polarity.

To avoid switching noise.

S7

ramp accel. channel B

Adjustment of ramp rate for increasing of the negative signal polarity.

To avoid switching noise.

S8

ramp decel. channel B

Adjustment of ramp rate for decreasing of the negative signal polarity.

To avoid switching noise.

P3

MAX +

Adjustment of maximum signal span for positive output signal.

To match the command signal span to the valve operating range.

P4

MAX -

Adjustment of maximum signal span for negative output signal.

To match the command signal span to the valve operating range.

P7

MIN +

Adjustment for positive output signal step at 0,1% command signal.

To compensate for the overlap of the valve spool.

P8

MIN -

Adjustment for negative output signal step at 0,1% command signal.

To compensate for the overlap of the valve spool.

P11

command signal polarity

Adjustment of the command signal polarity.

To match the command signal polarity to the valve operating direction.

E17

type of command signal 

device

Adjustment of the command signal option.

To match the command signal input to the input signal mode.

E19

cable break detection 

command

Adjustment of the operating mode for the command cable break 

detection. To turn on resp. off of the cable break detection of the 

command signal at a selected command signal option of 4...20 mA.

E25

MIN operating threshold

Adjustment of the MIN operating threshold.

To match the response sensitivity for the MIN-stroke step.
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Parameter overview for expert mode

Para-

meter
Description Unit

Parameter Range
Default Setting Comment

from up to

S11 ramp for int. command S1 ms 0 32500 0

S12 ramp for int. command S2 ms 0 32500 0

S13 ramp for int. command S3 ms 0 32500 0

S14 ramp for int. command S4 ms 0 32500 0

S17 default ramp ms 0 32500 0

P5 dither amplitude % 0 10.0 0

P6 dither frequency Hz 0 300 0

E21
option internal command

signal conjunction
–

0 = priority dependent 0 = priority 

dependent

Code W5 

only

1 = additive

E22
int. command signal 

ramp function
–

0 = quadrant dependent 

(S5...8) 0 = quadrant 

dependent1 = int. command depend. 

(S11...14)

E83
int. command signal 

functionality
–

0 = standard
0 = standard

1 = special option DFL

Individual Description of Expert Parameters

S11

ramp for internal 

command signal 1

Adjustment of the ramp rate for the internal command signal channel S1. 

To avoid switching noise.

S12

ramp for internal 

command signal 2

Adjustment of the ramp rate for the internal command signal channel S2.

To avoid switching noise.

S13

ramp for internal 

command signal 3

Adjustment of the ramp rate for the internal command signal channel S3.

To avoid switching noise.

S14

ramp for internal 

command signal 4

Adjustment of the ramp rate for the internal command signal channel S4.

To avoid switching noise.

S17

default ramp

Adjustment of the ramp rate for the default ramp.

To avoid switching noise.

P5

dither amplitude

Adjustment of dither amplitude.

To reduce the influence of solenoid friction.

P6

dither frequency

Adjustment of dither frequency.

To match the dither signal to the valve dynamic.

E21

internal command signal 

conjunction

Adjustment of the conjunction for the internal command signals.

To match the command signal logic.

E22

internal command signal 

ramp function

Adjustment of the ramp function for the internal command signals.

To match the ramp functionality.

E83

internal command signal 

functionality

Adjustment of the functionality for the internal command signals.

To match for the special option DFL.
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Failure message Description/corrective action

The Com Port is not available! Terminate the other program, or quit the message and select an-

other RS-232 port via the menu “Options > Port”. Afterwards recon-

nect the parametrizing cable.

Unable to open COM port Com port is not available. Quit the message and select another 

RS-232 port via the menu “Options > Port”. Afterwards reconnect 

the parametrizing cable.

There is no module/valve con-

nected or the communication 

is disturbed! Please check 

also the interface!

No data exchange possible. Either the electronic has been re-

moved, the port is mismatched, or the connection will be disturbed 

by strong electrical fields. Check if the Com port is set for “9600, 8, 

1. none, none” via the menu “Options > Port”.

Wrong password Retype the password, notice the exact spelling (case sensitivity).

Wrong input An unvalid character or a value outside the permitted range has 

been used at parameter entry.

Keep the entered para-

meters?

During parameter loading from the electronics memory the preset 

parameters from the left hand screen display may be rejected or 

maintained.

The chosen module/valve 

isn´t the same as the con-

nected hardware. Attention! 

Unsaved parameters will be 

lost.

In principle, parameters dedicated to a type which deviates from 

the connected valve may be edited. However, for data transmitting 

the correct valve has to be connected. If parameters will be loaded 

from a valve which deviates from the selected one, the param-

eters from the left hand side screen display of the program will be 

overwritten.

The chosen hardware isn´t 

the same as the connected 

module/valve.

The wrong valve type has been selected from the database, after-

wards the function “send all” has been executed.

Attention! Factory settings 

will be changed! Transmit 

anyhow?

Default parameters has been read out from the database instead 

from the valve via the function “receive all”.

file name.pxd already exists. 

Do you want to replace the 

file?

The file name already exists within the indicated directory. Select 

another name, another directory or overwrite the existing file with 

“OK”.

Error messages

Malfunctions when using the ProPxD software 

program will be indicated via appropriate failure 

messages.

Failure messages and corrective actions:
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Air Bleeding of Hydraulic System 

During initial startup, after an oil change as well 

as after the opening of lines or valves the hydrau-

lic system must be air bleeded. Air in the hydraulic 

system is very disadvantageous and therefore un-

desirable for the control system. The pipeline net-

work is vented at its highest point. The fitting may 

be loosened a little so that the air can escape with 

only a small amount of oil loss. When the oil is no 

longer foaming, the fitting is re-tightened. Afterwards 

all functions are run through, one after the other, in 

no-load operation with low pressure and with full 

cylinder stroke. Afterwards the system should be 

vented once more.

 After air bleeding the oil level in the tank must 

be checked, and refilled as necessary!

Filter

The function and lifetime of the valve are strongly 

affected by the cleanliness of the fluid.

 Dirt is the greatest enemy of the hydraulic 

system!

    

There are three important sources of dirt to watch 

for:    

•฀ contamination arising during installation

•฀ contamination arising during operation, friction 

wear

•฀ impurities from the environment

Basically a purity level class of 7 acc. NAS 1638 

is required.

    

 Pay attention to maintenance details!

    

Flushing    

It is recommended to flush the long pipelines by 

short circuiting the pressure and return lines, es-

pecially for large, central pressure oil stations. This 

prevents the installation dirt from entering the valve.

6. Maintenance 

 Service work may only be carried out by quali-

fied personnel. Detailed knowledge of the ma-

chine functions concerning switching on and 

off as well as of the required safety relevant 

technical tasks is required!

Periodical maintenance is essential for the longevity 

of the system and guarantees reliability and avail-

ability. The following properties of the system has 

to be checked in continuous short time intervals:

•฀ oil level in the tank  

•฀ max. working temperature  

•฀ condition of the pressure fluid (visual inspection, 

colour and smell of hydraulic fluid)

•฀ working pressure levels  

•฀ gas pre-load pressure on the pressure accumu-

lator  

•฀ leakage on all system components  

•฀ condition of filter elements  

•฀ condition of hose lines  

•฀ cleanliness of components

After a certain operating duration a change of the 

hydraulic fluid is required. The frequency of change 

depends from the following circumstances:

•฀ kind resp. grade of the pressure fluid

•฀ filtering

•฀ operating temperature and environmental con-

ditions
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7. Trouble Shooting     

Basis of troubleshooting is always a systematic 

approach. At first the following questions have to 

be checked:

•฀ Are there practical experiences with similar 

failures?

•฀ Have system adjustments been changed?

Afterwards starting of troubleshooting by means of 

a priority list of the most likely reasons.

 For suspect of a sluggish spool the valve may 

be flushed with clean pressure fluid.

 Troubleshooting in a hydraulic system requires 

in either case a systematic approach. The 

work may exclusively be performed by quali-

fied personnel, as it requires detailed know-

ledge about function and construction of the 

system. Reversals or dissassemblings may 

not be taken imprudently! Prior to the works 

it has to be clarified, if the system has been 

operated properly until the failure occured.

malfunction at hydraulic load runtime

- generally no function

- high frequent oscillation

- low frequent oscillation

- one way operation only

- speed variations at unchanging command

- different speeds depending on travel direction

- speed too low

- drifting without command

possible reasons for malfunction corrective actions

x hydraulic pump resp. motor defective replace hydraulic pump resp. motor

x x x x x x drive overloaded reduce pressure resp. speed, increase valve size

x x x x x x x valve contaminated clean pressure fluid, filter / flush valve

x x hydraulic fluid too viscous / too cold change fluid grade, provide operational temperature

x x x too low oil level within tank refill pressure fluid

x x x filter contaminated clean resp. replace filter

x x x x supply voltage too low keep supply voltage range

x supply voltage carries too much ripple reduce ripple

x x x command signal too low increase command signal

x command signal carries too much ripple reduce ripple

x dither signal amplitude too high reduce parameter P5

x dither signal amplitude too low increase parameter P5

x x x x x central connector contact failure clean contacts resp. replace connector

x feed cable interrupted fix feed cable

x x x x x x x wiring sequence incorrect correct wiring sequence

x x feed cable without shielding change cable grade

x*) pilot flow configuration incorrect correct pilot flow configuration

*) only for D*1FB
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Kaarst, Germany: Parker Hannifin GmbH Kaarst, Germany: Parker Hannifin GmbH

8. Accessories / Spare Parts

Accessories

The following accessories are available for the 

valves series D*FB/D*1FT:

D1FB:

bolt kit ordering code BK375

Code F0/M0/S0/G0: 

female connector 6+PE ordering code 5004072

Code W5: 

female connector 11+PE ordering code 5004711

D3FB:

bolt kit ordering code BK385

Code F0/M0/S0/G0: 

female connector 6+PE ordering code 5004072

Code W5: 

female connector 11+PE ordering code 5004711

D31FB:

bolt kit ordering code BK385

Code F0/M0/S0/G0: 

female connector 6+PE  ordering code 5004072

Code W5:  

female connector 11+PE  ordering code 5004711

D41FB:

bolt kit ordering code BK320

Code F0/M0/S0/G0:  

female connector 6+PE  ordering code 5004072

Code W5:  

female connector 11+PE  ordering code 5004711

D91FB:

bolt kit ordering code BK360

Code F0/M0/S0/G0:  

female connector 6+PE  ordering code 5004072

Code W5:  

female connector 11+PE  ordering code 5004711

D111FB:

bolt kit ordering code BK386

Code F0/M0/S0/G0:  

female connector 6+PE  ordering code 5004072

Code W5:  

female connector 11+PE  ordering code 5004711

Spare Parts

The following spare parts are available: 

D1FB:

seal kit NBR ordering code SK-D1FB-N

D3FB:

seal kit NBR ordering code SK-D3FB-N

D31FB: 

seal kit NBR ordering code SK-D31FTN

D41FB: 

seal kit NBR ordering code SK-D41FTN

D91FB: 

seal kit NBR ordering code SK-D91FTN

D111FB: 

seal kit NBR ordering code SK-D111FTN




